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Precautions

1. Important Safety
Instructions

¢ Read these instructions.

¢ Keep these instructions.

¢ Heed all warnings.

¢ Follow all instructions.

¢ Do not use this apparatus near
water.

¢ Clean only with dry cloth.

¢ Do not block any ventilation
openings. Install in accordance
with the manufacturer’s
instructions.

¢ Do not install near any heat
sources such as radiators,
heat registers, stoves, or other
apparatus (including amplifiers)
that produce heat.

* Do not reverse the safety purpose
of the polarized or grounding-
type plug. A polarized plug
has two blades with one wider
than the other. A grounding
type plug has two blades and
a third grounding prong. The
wide blade or third prong is
provided for your safety. If the
provided plug does not fit into

your outlet, consult an electrician
for replacement of the obsolete
outlet.

Protect the power cord from
being walked on or pinched
particularly at plugs, convenience
receptacles, and the point where
they exit from the apparatus.
Only use attachments/accessories
specified by the manufacturer.
Use only with the cart, stand,
tripod, bracket, or table specified
by the manufacturer, or sold with
the apparatus. When a cart is
used, use caution when moving
the cart/apparatus combination
to avoid injury from tip-over.

Unplug this apparatus during
lightning storms or when unused
for long periods of time.

Refer all servicing to qualified
service personnel. Servicing is
required when the apparatus has
been damaged in any way, such

as power-supply cord or plug is
damaged, liquid has been spilled
or objects have fallen into the
apparatus, the apparatus has
been exposed to rain or moisture,
does not operate normally, or has
been dropped.

WARNING: To Prevent fire or shock hazard
do not expose the set to rain or moisture.

2. Notice

¢ These servicing instructions
are for use by qualified service
personnel only. To reduce the
risk of electric shock, do not
perform any servicing other than
that contained in the operating
instructions unless you are
qualified to do so.

¢ The apparatus shall not be
exposed to dripping or splashing
and that no objects filled with
liquids, such as vases, shall be
placed on the apparatus.

¢ The mains plug is used

as the disconnect device. The

disconnect device shall remain

readily operable.
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To reduce the risk of electric shock, do not remove the cover (or back).
CAUTION ' ho (orback)
- - No user serviceable parts are inside.
FISK OF BLECIRIC SHOCK .. . .
D0 NOT OPEN Refer servicing to qualified service personnel.
WARNING  SHOCK HAZARD-DO NOT OFEN
AVIS: RSGUE DF CHOC BLECTRIGUENE PAS QUVRIR
The Lightning Flash with arrowhead symbol within an The exclamation point within an equilateral triangle is intended
equilateral triangle, is intended to alert the user to the presence to alert the user to the presence of important operating and
of un-insulated “dangerous voltage” within the product maintenance (servicing) instructions in the literature accompanying

enclosure that may be of sufficient magnitude to constitute a

risk of shock to persons

3. Copyright
This manual is protected by copyright
laws.
Copy, use and reproduction of this
manual in part or whole without
Manufacturer’s prior written approval are
prohibited.

the product

4. Disclaimer

The manufacturers, distributors and
agents are not liable to any kind of
damage caused by the use of the

information contained in this manual.
The instruction and descriptions which
this manual contains are based on the
time of this manual’s production.

The manufacturer constantly updates it
with new functions and technology.

All the specifications are subject to
change without prior notice.

5. Trademarks

Homi

ik R TIEN AL TOMB T TR AT

HDMI, the HDMI logo and High-
Definition Multimedia Interface are
trademarks or registered trademarks of
HDMI Licensing LLC
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Betore You Begin

1. Main Features

+ Full HD Satellite PVR receiver

+ HDMI Video & Audio Output (576i, 576p, 720p,
1080i, 1080p)

¢ H.264/MPEG4 (HD/SD), DVB-S2 Compliant

¢ Recording & Playback with External USB 2.0
Devices

¢ Recording and Time Shifting Simultaneously
¢ Event Recording by EPG
+ USB 2.0 Host ports (MP3 Player & JPEG Viewer)

¢ Various Media File Format Playback (Xvid file
Playback)

¢ 10/100 Base-Tx RJ-45 port
¢ 4-Digit Alphanumeric LED Display

¢ Fully compliant with DVB-S2
¢ Blind scan

* Multi-LNB Controlled by DiSEqC Control Version
1.0, 1.1, 1.2 and USALS

* Multi-Satellite Search

¢ Support EPG (Electronic Program Guide)

* On-Screen Display with Full Color & Resolution
* Favorite Service Groups

+ Powerful Service Control by Favorites, Lock, Skip,
Move and Delete

¢ Service Sorting by Alphabet, Transponder and CAS
+ Multi-language Supported (OSD & Menu)

* Teletext Support

* Maximum 10,000 Services Programmable

¢ PIP (Picture in Picture)

* Parental Lock / System Lock / Installation Lock

* CVBS Video & Audio Output via RCA

+ HDMI Video & Audio Output

¢ Optical Output for Digital Audio (SPDIF)

+ Software & Service Database update via USB and
Ethernet port
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2. Accessories

User’s Manual Remote Controller RCA cable (Option)
AAA size batteries X2 HDMI cable USB hub
Adaptor TV mount bracket (Optional) IR extension (Optional)
= %‘
NOTE: If any accessories listed above are missing, contact the sales representative where you purchased this unit.

Itis ready to be mounted behind of the TV. Use the screws provided to hold the components in place.
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1. Front Panel Configuration

10N

1. Display : 4. STANDBY / REMOTE Indication LED (RED / GREEN):
The 4-digit shows channel number or menu state in The LED (RED) lights on in standby mode. / The LED
normal mode, shows local time in standby mode. (GREEN) lights on when a key on the Remote Control
2. POWER Button: Is pressed.
Press to switch between STANDBY and POWER ON 5. Remote Sensor:
modes. Receives signal from remote controller.
3. CH Up/Down Button:

Press to change services in normal mode, to move
the highlighted-bar UP/DOWN in menu mode.

ardware Descript




XtRuISER

XOsSsR385HO

2. Rear Panel Configuration

. IRextension: The 2.5mm mini plug is

connected to the“IR Rec” jack to use IR
extension when XDSR385HD is mounted
with optional bracket. (Front remote
sensor will not be operated when IR
Extension is connected)

. PCMCIA : To receive other pay-tv service

you need a CA-Module(Viaccess, Irdeto,
Nagravison, etc.) and a smart card from
the service provider.

. SMART CARD READER : Insert smart card for

4.
5.

encrypted service access.

LNBIN: Use to connect a satellite antenna.

LNBOUT: Use it when connecting to
another STB for loop-through.

RS-232( : Serial port for firmware update
and data transfer.

Ethernet : Local area network port for
direct computer connection.

USB : Use it when connecting to external
USB storage device.

9. HDMI : Connects to the TV by using a

HDMI cable for the best quality picture
and audio.

10. AVOUT: Connects to the TV or VCR using
a optional RCA cable (Stereo audio
output / White, Red, Composite video
output / Yellow)

11. SPDIF : Connects to the audio system
using a S/PDIF cable. (digital audio)

12. D/Cpower socket : Connects the adaptor
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3.

Remote Control Unit

10.

POWER: Turns the STB On/Off.

MUTE/Resolution: Turns the sound On/Off. / To select the
resolution format press and hold Resolution button. You will
see the resolution menu. Each time you press the Resolution
button, the resolution changes in the following sequence:
576i>576p >720p > 1080i > 1080p by pressing the Exit button it
turns the sound On/Off again.

Numeric: Controls the numerical operation and service
numbers directly.

Subtitle: To show multilingual subtitle.
Teletext: To show the digital teletext.

OK or Service List: Show the service list in non-menu mode and
select an item or confirm in menu mode.

ARROW Buttons

. Up & Down Buttons: To change the value of a selected item with

preprogrammed values in menu.

. Left & Right Buttons: To move the cursor left and right in menu.

Menu: To enter the main menu or to move to the previous
menu.

EXIT: Exit from the menu or pop-up window.

Play List: To show the file list in the USB Storage Device or
Network Storage Device.
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11.
12.
13.
14.
15.

16.

17.

18.

19.

Favorite: To display the satellite group and the favorite groups.
EPG (Electronic Program Guide): Show the TV/Radio program guide.
Recall: Moves to previous service.

Volume Up & Down: To change the Volume.

Play/Time shift: Display the progress bar of playback when no
progress bar is displayed. Start playback with normal speed.
Return to normal speed from trick mode.

Channel Up & Down: To change service channel.

Pause: This key is used to pause the video. Press once more to
resume the video.

Rewind: Rewinds at high speed. Each time you press this button
the rewind speed is increased.

STOP: To stop time shifting, play back or recording.

20.

21.

22,
23.

25,

26.
27.

28.

Fast Forward: Fasts forward at high speed. Each time you press this
button the speed is increased.

Previous File: To play the previous MP3 file in MP3 play mode. This
button is also used to jump back to beginning of recording
during a playback.

Recording: To start Recording.

Next File: To play the next file. This button is also used to jump to
end of recording during a playback.

. Color Buttons
. RED: Used for special function in menu. RED key is used to sort

lists in service list or go to previous day search in EPG or make/
delete the current position as a bookmark.

. GREEN: Used for special function in menu. Green key is used to

set favorites setting in service list or go to the next bookmark
position.

. YELLOW: Used for special function in menu. Yellow key is used to

find service in service list or change the audio track.

. BLUE: Used for special function in menu. Blue key is used to set

service list option in service list or display Multi-Picture.

Page Up& Down: Move to the next or previous page if more than one
page are available. This button also is change the location of sub
picture in PIP.

TV/RADIO: Switches between TV and Radio.

Information: Shows the information of current program. If you press
one more, detail information box will be shown.

PIP Buttons

PIP (Picture in Picture): To set PIP window.

. PIP Swap: Switching between main-picture and sub-picture
. PIP (Picture in Picture) Service List: To shown the sub-picture service list.
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1. Receiver to Adaptor

@® Connect the A/C power cord between A/C power cord socket of receiver and A/C outlet.

Satellite tuner

Connecting diagram
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2. Receiver to TV with Digital A/V Output

@® Connect the HDMI Cable to the HDMI Connector of the TV.
@® Connect SPDIF to Digital audio input of the equipment (Digital Audio)

D:gftaf Audio Equ!pmeur

0

_
i
, — B .

-~ cezenm
NOTE: Depending on the A/V equipment you own, there are various ways you can HD content, we recommend that you connect your high definition display with
connect the STB. To choose the best connection option, please refer to the manual a HDMI cable. HDMI supports standard, enhanced or high-definition video and

of the eauipment vou would like to connect to. To aet Hiah Definition playback of multichannel audio in a sinale cable.



/(L?UISE‘\' ” XOSR3I8SHD

3. Receiver to TV with Analog A/V Qutput 4, Connecting to Antenna Cable
@ Connect the VIDEO and AUDIO L, R to VIDEO IN and @ Using Single DISH: Connect the Satellite
AUDIOL,RIN of TV. Antenna cable to LNB IN.

l =
....K CE 2o

NOTE: The composite connection(RCA cable) is recommended for analogue TV
You cannot view high definition video with the composite video connector.
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@ Using DiSEqC switch: Connect the cable of DiSEqC @ Using DiSEqC motor: Connect the cable of DiSEqC
switch to LNB IN. motor to LNB IN.

Satellite Dish 2 | MoreDish... |




/(L?UISE‘\' 18 XOSR3I8SHD

5. Guide to mounting an STB on TV back panel (Optional)

¢ Install the mount bracket on back panel of TV using ¢ Mount your STB on the bracket.
the screws provided.

¢ PLACEMENT: The IR receiver should be located so that it is not
directly facing a light source such as lamps or displays. When
mounted near a display, it should be flush to the display and away

from light reflections that may occur.
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Guide of Functions

1. Selecting a Service

To select the desired service
(channel), please refer to the
instructions below.

1.1 Using CH UP/DOWN buttons

You can navigate between
services by pressing CH UP/DOWN
buttons. Whenever you press
the CHUP (DOWN) button, current
service will be changed to next/
previous service. Please press
CH UP or CH DOWN button until
you fine the service you want to
watch.

1.2 Using Service List

To select the desired service

in the service list, you should
firstly display the service list by
pressing the 0K button.

Use the ARROW buttons to select
a desired service and press the
OK button.

You can see that the service is
changed in the small screen on
the top-right.

To watch that service, press the
OK button once more.

To watch the previous service,
press the EXIT button.

In the Service List window,
you can also select additional
functions with the COLOR
buttons. Press the RED button,
and you can sort the services
by the Alphabet, Transponder
(TP), Group, Tuner and CAS
(Conditional Access System).

Press the GREEN button, and you
can add the services to one of
10 Favorite List.

Press the YELLOW button, and you
can search & find the service via
a virtual keyboard.

Press the BLUE button, and you
can adjust service list option.

1.3 Using Simple Service List

If you press NUMERIC buttons or
UP/DOWN ARROW button, instant
service list will be displayed.

Select the desired service by
using the ARROW button, and
press OK button to watch.

You can also enter the service
number directly by using the
NUMERIC button.
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1.4 Using Recent Service List

To display recent service list,
press the RECALL button for a
short time.

To return to the previous service
that you were watching, press
RECALL button twice or for a
longer time.

Choose the service from the
recent service list, use the ARROW
button to select, and then press
the OK button.

Press EXIT button to exit from
the recent service list.

& ONEHNEWS

430

2. Information Window

If you want to view the
information of the current
service that you are watching,
press INFO button. Then the
Information window will be
displayed.

This Information window is
automatically displayed when
changing between the services.

This window contains much
useful information such as
service number, service name,
scrambled types of service,
teletext, subtitle, Audio
indication for Dolby Digital,
Time duration of the service and
so on.

By pressing INFO button once
again, you can get more
detailed information about the

service.

3. Multi-Picture Display.

Press the BLUE button to display
multiple pictures and use the
RED button to select the display
options for 9 or 12 multiple
pictures.

4. Electronic Program
Guide (EPG)

Electronic Program Guide (EPG)
allows you to see program
schedule and program infor-
mation from the service which
includes this data as part of their
transmission. Multiple services
will be shown with a time line of
programming events. The EPG
supplies additional informa-
tion of channel service, such

as program listings, start/end
times and detailed information
about the program listings for
all available services. The avail-
ability and details of information
of these program details can be
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varied, depending on the par-
ticular broadcasters, individual
services.

# Press the EPG button, then the
EPG menu will be displayed.

¢ Use the ARROW buttons to
move to other services or to
see previous/next guide.

¢ Press the EPG button once
to view full EPG with multi
service list, and press it twice
to view the additional EPG
information of a specific chan-
nel service. Keep pressing the
EPG button to toggle between
the full and detailed menus
of EPG.

# Press the GREEN button to view
next day EPG and the RED but-
ton to view EPG for a previous
day.

# Select the program by using
the ARROW buttons then set
the event timer by pressing
OK.

* You can schedule a recording
with the EPG menu as follows.

- Press RECORD button to sched-
ule the event. This schedule

can be checked in the menu
of Timer Settings, in the Sys-
tem tool menu.

- To cancel the schedule of the
recording, press the 0K but-
ton for the appointed event.

- To edit the schedule of the
recording, press the RECORD
button for the appointed
event.

5. Favorite Group

Press the FAV(Favorite) button to
view all favorite groups such as
sports, movie, drama, satellite
group and so on. Scroll through
the various favorite group using
the UP/DOWN ARROW buttons, and

select the desired favorite group
by pressing 0K button.

6. Volume Control

¢ To adjust the audio volume,
press the VOL UP/ DOWN but-
tons.

¢ Audio volume control bar will
be displayed at the top of the
screen and disappear after 4
seconds.

¢ When necessary, press the
MUTE button to turn on/off the
audio sound.

NOTE: The mute function
remains set while you change
services.

7. Pause

PAUSE button is used to freeze
the video. Press PAUSE button
once more to resume the video.
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8. Subtitle

You can select the language for
a Subtitle, if the program pro-
vides subtitle information.

¢ Press the SUBTITLE button on
your remote control unit.

* Select the desired subtitle lan-
guage then press 0K button.

# The subtitle will be displayed
in the selected language at
the bottom of the screen.

* To turn OFF the subtitle from
the screen, Select ‘0ff’ from
the subtitle language list.

NOTE: When program does not

provide subtitle information,

SUBTITLE button will not be active.

9. Audio Control

Press YELLOW button on live TV
service to display Audio Control
menu. You can set Audio Track /
Sound Mode / Sound Level.

¢ Audio Track:

You can see all the audio track
of the service you are watching.
Use the ARROW buttons to
choose the preferred audio
track. If you select Auto, audio
track will play as what you set
for audio language in language
setting menu.

¢ Sound Mode:

To set sound mode, Stereo /
Mono / Left / Right.

¢ Sound Level:

To set sound level, Low
(-30%) / Normal / High (+30%)
/ Off:
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10. Teletext

When the TELETEXT icon
on the INFO Banner, press

the TELETEXT button to view the
teletext.

11. PIP (Picture in Picture)

When you press the PIP button,
a sub picture screen will appear
on the main screen view.

If you press the PIP button one
more time, the primary picture
and the sub picture will appear
together side-by-side with the
same size. The picture of the
left side is the primary and the

picture on the right side is sub.
If you press the PIP button one
more time, the sub picture will
disappear.

¢ In the PIP mode, you can
change primary and sub with
the PIP SWAP button.

¢ If you press the PAGE UP/DOWN
button, the location of sub

picture is changed.

* |f you press the PIP SERVICE LIST
button, you can see the list of
services of sub picture.

You can change the service
of the sub picture from the
service list shown.

NOTE: Changing services of sub
the picture could be limited by the
condition of the tuner connection
or a recording event ongoing.
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PVR (Personal Video
Recorder) Function

&
1. Recording

You can select a recording
storage device with the
following sequence:

Menu > Configuration >
Recording Option > Record
Device.

Default is set to ‘USB’.

1.1 Recording methods

There are 3 type recording
methods.

(Instant Recording / Time
Scheduled Recording / Event
Scheduled Recording).

Instant Recording:

Press RECORD button to start
recording instantly at anytime.

Time Scheduled Recording:

- InTimer Settings menu, you
may set the time & program
to record your desired service
program.

- (Go to Main Menu > System
Tools > Timer Settings)

- Press the GREEN button to acti-
vate the new timer edit screen.

- In the Timer Edit screen, you
may choose start date/time,
duration, service, mode, type
(Recording/Play) then simply
press the Yes button to sched-

ule your recording event. Please

note that the minimum offset
time of 3 minutes is required
from the Start time & current
time for appropriate recording
process to take place.

- Event Scheduled Recording via EPG:
- In the EPG menu screen, you

can choose the event you wish
to schedule or record.

- While watching the LIVETV
screen, press the EPG button to
access the EPG menu screen.

- Go to the event which
you wish to view at the time
indicated on the EPG schedule,
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then press OK. The event will be
scheduled with the BLUE play
icon. This BLUE play icon means
that you want to just watch the
event at the scheduled time.

- Press the OK button one more
time, then the event will be
scheduled with the RED dot
icon. This RED dot icon means
that you want to record the

event at the scheduled time.
-When you set an event for
scheduled recording via the EPG
menu. It automatically sets a
Timer Event in the Main Menu >
System Tools > Timer Settings.

1.2 Recording Edit

Press REC button while recording
to see the recording message
window.

® Pause: Select Pause Recording
then press OK to pause the
current recording process.

# Duration: Set recording
duration. Press LEFT/RIGHT
ARROW button to change
recording duration.

¢ Stop Position:

Set the finishing time of
recording.

- End of current event: finish
recording at the end of current

event

- End of next event: finish recording
at the end of next event.

- Not Available: EPG is not
available.

# Record Slot: When you are
recording 3 services, you can
select Primary / Secondary
/ Tertiary by pressing Left/
Right Arrow button, then go to
Change Service and press 0K
button to show that recording
service.
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1.3 Long Time recording

During lengthy time recording
processes of 4GB (Giga Byte)
or more, additional files may
be created per every 4GB. (For
example; aaa.ts, aaa.tsl, aaa.
ts2... and so on).

You must remember not

to delete any of duplicated file.
These files are only able to be
viewed with your PC not with
the receiver (STB).

1.4 Pause during recording

¢ When the PAUSE button is
pressed during recording,
only the live video is paused,
but recording is continued at

the selected recording device.

(Menu > Configuration >
Recording Option > Record
Device)

Press PAUSE button once again
and event will resume from the
pause time.

# During recording, press the
PLAY/TIMESHIFT button to show
the Play bar screen.

* While the Play bar is shown
on your screen, you may use
the LEFT/RIGHT Arrow button to
move (forward & backward)
freely within recorded time.

* If you press YELLOW button in
the Play bar, you can set the
Position Jump time at Auto /
10sec / 30sec / 1min / 2min /
4min / 10min. Then press LEFT/

RIGHT Arrow button to jump as
you set the time.

¢ |f you press the STOP button,
it will go to LIVE and you may
press PREVFILE button to view
the recorded file from the
beginning.

# STB can record up to
3 different services
simultaneously.

When recording 3 services at the
same time, you can press the
STOP button to see a message
window of current recording
status / information.

If you select one of the 3 or

2 recordings and press the 0K
button, that recording service
will be stopped.

If you press the STOP button
during recording 1 service,

a recording stop message
window will appear. Then select
YES to stop recording.

NOTE: If you want the recording

up to 3 services, please format

the storage devise with ‘NTFS’ or
Journaled(JFS)’ file system.

Menu > Storage Manager > Format
> File System > select ‘NTFS’ or
Journaled (JFS)".



/(L‘\'UISE‘\' 27 XOsR3I85HD

2. Time Shlftlng ¢ |f pressing the PAUSE button ¢ When the play bar is 4min / 10min. Then press LEFT/
during Time shift, the live displayed on your screen, RIGHT Arrow button to jump as
video is paused but the you may use the LEFT/RIGHT you set the time.

You can select a storage device

. temporary recording for Arrow buttons to move freely . f the STOP butt
for a temporary file of the Time . e . . you press the utton
shifting V\'I)ith t}:Ie following time shift is contlnue.d atthe through the recorded times while time-shifting, the screen
sequence: selected storage device. bar. will be turned to a live TV
Menu > Configuration > ® Press the PAUSE button once ¢ If you press YELLOW button in channel. You can also use PREV

. o . . in. then th ill the Play bar, you can set the FILE button to move to a start
Recording Option > TimeShift again, then the event wi . - : ) .
Device. resume from the paused time. Position Jump time at Auto / location of the Time-shifted
: 10sec / 30sec / Imin / 2min / file.

Default storage device is set to ¢ While watching live TV, press
‘USB’ the PLAY/TIMESHIFT button to

show the play bar on your
screen.
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3. Playback (Play List)

You can playback many files
with the Playlist which you

access by the PLAYLIST button.

In the Playlist, you can check
and playback recorded files,
multimedia movie files, MP3
mausic files, and image files.
With the LEFT/RIGHT ARROW
button, go to the Recorded
Files, Imported Files, Music
and Photo category and
check & for playback files in
each category.

If press the PLAYLIST button,
you can see all playable
files. In this mode, Green
button is not in operation

(not working). And when you
select the file, you will not be
able to select the different
types of file format files
together at once.

You can press LEFT/RIGHT Arrow
button to move to Recorded
Files / Imported Files / Music
/ Photo / Play List menu.

3.1 Recorded Files

* If you press RIGHT Arrow button
in Play List, you can go to
Recorded Files menu.

* Locate the recorded file(s)
you wish to play with the UP/
DOWN button and press the
OK button to playback the
recorded file(s).

* To choose a particular
selection of files, select a
desired file and press the RED
button. Press the 0K button to
begin the selected files.

# Select Device: Press PLAYLIST
button one more time in the
Playlist mode to see “Select
Device” window, and select
the device which has the file
you want to play.

NOTE: “Select Device” window
shows devices which are currently
connected to the STB.

Sorting: If you press the YELLOW
button, you can sort the files by
Time / Name / Size / Type.

¢ File Option:

If you press the BLUE button, you
can select a option for Delete,
New Folder, Move to Folder,
Copy to Device, Rename, Lock/
Unlock. You can select multiple
files together and delete or
move all of them at once.

- Delete: To delete file(s)

- New Folder: To make new
folder. Default name of
the folder is “Group#”.

- Moveto Folder: To move the

selected file(s) to a folder
you want. This option is
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available if there is no
folder.

- Copyto Device: To copy the
file(s) to other storage
device. This option is
not available if only
one storage device is
connected.

- Rename: To rename the
folder or file.

- Lock/Unlock: To lock and/
or unlock the file with
your PIN Code. You must
select a file to do this
option.

3.2 Imported Files

¢ |f you press RIGHT ARROW
button in Recorded Files, you

can go to Imported File menu.

® Locate the file(s) you wish to
play with the UP/DOWN button
and press the 0K button to
enjoy the movie.

* To choose a particular
selection of files, select a
desired file and press the RED
button. Press the 0K button to
begin the selected files.

¢ You can use the same ‘Select
Device; ‘Sorting’and ‘File
Option’features as in the
Recorded Files.

3.3 Music

* If you press the RIGHT ARROW
button in Imported Files, you
can go to Music menu.

* If you press the RECALL button,
you can enjoy music with
Shuffle playback and repeat.

You can use the same ‘Select
Device’, ‘Sorting’ and ‘File
Option’ features as in the
Recorded Files.

3.4 Photo

® If you press the RIGHT ARROW
button in Music, you can go to
the Image Photo menu.

* If you press the RED button
or 0K button, you can start
the slide show of image files.
Press the EXIT button to stop
slide show.

- REDbutton: Auto Slide show

- OKbutton: Manual Slide show

¢ |f you press the GREEN button,
you can adjust the Slide Time,
Repetition, Title, Down-scale.

* You can use the same ‘Select
Device’, ‘Sorting’ and ‘File
Option’ features as in the
Recorded Files.
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4. Bookmark 5. Trick mode

* When the Play bar is ¢ When the play bar is on, user ¢ The user can change the ¢ You may press the PAUSE
displayed, you may move to can move / jump between the speed of a fast forward play button at any time to pause a
desired time and book mark bookmarks by pressing the with FF (Fast Forward) button. pre-recorded event. Press the
it by pressing the RED button. GREEN button. Press FF button to change PAUSE button once again to
Bookmark(s) are indicated the speed to x2, x4, x6, and resume play of the recorded
with a Green line on the play ¢ If you wish to delete any x8. If you once again press event.
bar. Also, you may press the Bookmarks, go to that FF button in its x8 mode, it
RED button to activate the play bookmark by pressing the returns to normal(x1) speed
bar to mark your bookmark(s). GREEN button, then press play.

the RED button to delete the

® You can also change rewind
current bookmarks.

speed with the REWIND button.
Press REWIND button to
change the speed to x2, x4,
x6, and x8. If you press the
REWIND button again in it is

at the x8 mode, it returns to
normal speed.
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System Tools

1. Storage Manager

2. Timer Settings

3. Service List Manager
4. Data Transfer

Installation

1. Dish Setting

2. Positioner Setting
3. Service Search

4. Network Setting

5. System Recovery

6. System Information

Configuration

Menu Map

1. Recording Option
2. Parental Control

3. Display Setting

4. Time Setting
5.Language Setting
6. A/V Output Setting

1. Calculator

2. Calendar
3.CAS

4. Plugin
5.Free TV+

6. Internet TV+
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Main Menu of Guide

To display the menu, press the

MENU button at any time. You
can select the sub menus by
using the ARROW buttons.

The selected sub menu
becomes highlighted. After
selecting (highlighting) the sub
menu you want to access, press
the 0K button. If you want to
return to the previous menu,
press the MENU button. And if
you want to exit from the menu,
press the EXIT button.

1. System Tools

1.1 Storage Manager

The items in this menu allow
you to access and control the
storage devices that you want.

# Current Device: Select the storage
device you want to access with
the ARROW/OK buttons.

# Status: You can see the
information of current
connected devices, such as
‘Mounted’, ‘Not Available’

# File System: It shows the file
system of the current device.
You can also select desired file
system that you want when
you format the device.

NOTE: NTFS is the recommended
file system to format, and it will be
also recognized in Windows system

¢ Total: Displays total size of
current device.

® Free: Displays free size of
current device.

¢ Format: If you press the 0K
button to format current
device, the device will be
formatted with above file
system.

NOTE: When file system is
‘Unknown’, the device will be
formatted with ‘NTFS'.
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# Storage Check: Check the
current connected device.

¢ Play List: Press 0K button to
move to ‘Play List’ menu
directly.

1.2 Timer Settings

Insert a new timer entry or

modify an existing timer entry.

¢ To add new timer entry: Press
the GREEN button. Timer Edit
window will popup. You can
set the specific start date,
time, duration and service for
its reservation. And you can
choose one of Timer Modes as
‘Once’ or ‘Daily’ or ‘Weekly’.
You can choose timer
operation type as’'Recording’
orjustto ‘Play’.

- If you choose ‘Recording’,
it will start recording at that
time.

- If you choose ‘Play’, it will
change and tune to the
service that you wish to
watch.

- If you set Alarm Confirm
Message to ‘On’, alarm
message will activate. Or
choose ‘Off” to disable.

* To modify existing timer entry:
Choose the timer entry which
you wish to modify and press
the OK button.

¢ To delete an existing timer entry:
Choose the timer entry that
you want to delete and press
the RED button.

# Press YELLOW button to enter
to Calendar.

# Press BLUE button if you want
to delete all the event(s).

NOTE: Ifyou reserve one or more
event through the EPG menu, the
reserved event(s) will be added to
Timer Settings automatically.

*

1.3 Service List Manager

Service List Manager menu
will appear when you press
the OK button.

You can select Edit Mode by
pressing the YELLOW button.

Lock Services: All service lists
will be shown on the left side
of the window, the middle
will show the list of service

to be locked. By using the
ARROW and OK buttons, you
may move the chosen service
to the middle window to lock
that service. Services can

also be moved back from the
middle to the left side to un-
lock them.
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* Move Services: All service lists

will be shown on left side

of the window, services to

be moved will be shown on
the middle window. Move

the service to the middle
window by using the ARROW
and OK buttons, then the
middle window service will be
moved to a specified location
when the desired location is
selected from the left window.

# Delete Services: All service lists
will be shown on left side
of the window. By using the
ARROW and OK buttons you
may select services to be
deleted by placing them in
the middle window. The press
the GREEN button to delete the
selected services.

* Skip Services: All services will
be shown on left side of the
window, the middle window
will only show the services

that are chosen to be skipped.

By using the ARROW and 0K
buttons you may move the
selected services from the
left to middle window to skip
them.

# Set Favorite Services: Use the
ARROW and OK buttons to
select your desired favorite

*

group. Once, favorite group is
chosen, the left side window
will show all service lists and
the middle window will only
show the selected services of
the favorite group selected.

By using the ARROW and 0K
buttons, you may ADD the
desired services to a favorite
group or DELETE any from
the favorite group. The name
of the favorite group can be
edited by pressing the GREEN
button.

You can go to Select Favorite
Group by pressing GREEN
button. In this mode, you
can select Lock Group / Edit
Group Name / Add Group /
Delete Group.
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# Edit Services: All services name
will be shown on the left side
of the window.

Move the highlighted bar to
the service where you want to
edit its name and press the 0K
button for Edit Service menu.
Then move the highlighted
bar which you want to edit.

You can edit Service Name,
Video Stream Type, Video PID,
Audio Stream Type, Audio PID,
PCR PID.

1.4 Data Transfer
# Transfer all System data to USB

storage: If you want to transfer
and use BOTH of the current
system parameters and
service data in the future, this
menu will allow you to store
all data to your USB device.
Press OK button to store all
current data to an external
USB storage.

Transfer Service data to USB
storage: If you want to transfer
and use ONLY the service data
in the future, this menu allows
you to store current service
data. Press the OK button to
store the current service data
to your external USB storage.
The service data can also be

viewed and edited on a PC
with an appropriate editor
(DrEdit) for the file saved.

¢ Data download from USB storage
device: This menu allows you
to download the saved data
from the external USB storage
to your STB. Press 0K button to
download data.

NOTE: If no USB device is connected
USB slots, then a Menu item will not
be available.

2. Configuration

2.1 Recording Option

¢ Alarm Confirm Message: Turn
‘ON’ this Alarm message to
indicate and show the alert
pop-up message when there
is a reserved recording event.
Alert message will show 3
minutes before starting time
of reserved recording event.

¢ Recording Stop Message:

- Set ‘On”: When you press the
STOP button while recording,
then a confirmation window is
displayed.

- Set ‘0ff When you press the
STOP button while recording,
the STB will stop the recording
process immediately /
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instantly without asking the - Manual: TimeShift will be pressed the video will move

additional confirmation from
the user.

¢ Extra Recording Time Before (Start)
& After (Finish):

- You can add extra recording
time before start / after
finish (Imin/2min/3min/4min
/5min/10min/15min/off) to
scheduled recording events.
If you set an extra recording
time by using the ARROW and
OK buttons, the scheduled
recording event will have
a ‘Start’/ ‘Finish’ time of
additional recording time
added to the basic event. This
option only works for real
time events. But, when you
schedule a service recording in
the Timer Settings menu, this
option has no affect.

< TimeShift Start: You can choose
the method of TimeShift
function.

- Auto: TimeShift function is
automatically activated.

- Off: TimeShift function will be
disabled.

activated when the Pause key
is pressed.

* TimeShift Duration: You can
adjust TimeShift duration
in 30 minute intervals.
(Off /30min /60min /90min
/120min). This duration
defines the maximum time
length of the TimeShift as
long as the storage device has
enough memory space left.

* Playback Position Jump: When
you use LEFT/RIGHT ARROW
button to move back/forward
through the recorded time
bar, You can select the time
intervals. (10 Sec / 30 Sec /
IMin /2 Min /4 Min / 10 Min
/ Auto).

* Playback Numeric Function:
This selection of function
defines the operation type
of the NUMERIC buttons of
your remote control unit
(RCU) while the ‘Playbar’is
displayed on the screen.

- Commercial Skip: When the

NUMERIC buttons (1 to 9) are

forward according to the
NUMERIC buttons pressed. For
example; when ‘I’ is pressed,
Tmin move forward, ‘5’ is
pressed, 5min move forward
from current position. When
‘0’ is pressed, it will move
back for Tminute.

- Percentage Move: When the

NUMERIC buttons are pressed,
the video will move to the
location of that % percentage
of numbers pressed. For
example; if you press ‘10°, you
will move to the 10% location
of the total video length. If
you press ‘99’ you will move
to the end of the video clip
recorded.

# TimeShift Device: You can select
the TimeShift Device you wish
to use.

- USB Network Drive.

# Record Device: You can select
the Recording device you
wish to use.

- USB Network Drive.

2.2 Parental Control

User’s access rights to a service
and programs are controlled

by a 4-digit secret code that is
defined by the user. Whenever
you attempt to access the
parental control menu, a pop-
up window will ask you to input
a PIN code. (If necessary, you
can changeiit.)

NOTE: The default PIN code is
‘0000’
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# (Censorship: Set the parental
guidance rating of highlight-
ed censorship classification.
The parental level is given as
an age-based number.

*

*

Change Pin code: To change your
PIN code, input the new PIN
code using the NUMERIC but-
tons. To verify the new PIN
code, input the new PIN code
again.

System: Set the access rights to
the System menu.

Installation: Set the access
rights to the Installation
menu.

Configuration: Set the access
rights to the Configuration
menu.

* Edit Service: Set the access
rights to the Edit menu.

# Plugin: Plugin Set the access
rights to the Plugin menu.

2.3 Display Setting

* Info Box position: Set a position
of the information window.

* Info Box Display Time: Set the
time duration of the informa-
tion window being displayed
on the screen after changing
services.

* Info Box Event Type: Set the
event type that display in left
bottom part of the informa-
tion window.

- Present Event with Time:

Display the present event
name with time. (Default)

- Present and Follow Event:
Display the present and

following event name.

# Volume Bar Display Time: Set the

time duration of the volume bar

being displayed on the screen
after changing audio volumes.

# EPGTime scale: You can set the
time scale in hours which is
displayed for a program in the
EPG window.

¢ Start MHW-Epg Automatically: You
can set on MHW-Epg to start
automatically.

¢ Zapping Mode: You can set the

zapping mode as follows
(zapping mode is when
changing services).

Black screen: Display a black
screen when changing
between services.

Freeze: Display the last still picture
when changing services.

Simple Service List: To set the
simple service list ‘On’to
display or ‘Off “.

On: Press UP/DOWN ARROW
button to display the simple
service list while watching
live TV.

0ff: If you set Off, channel Up/
Down when you press UP/
DOWN ARROW button.
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2.4 Time Setting

¢ Time Setting: To set the current
time, you can use two modes;
Auto or Manual.

* Local Offset: Enter the
offset value by using the
standardized information of
current service area.

# Daylight Saving: If you want to
apply daylight saving, select
the counter by using the
ARROW buttons.

# (lock Mode: Select the type of
clock display (12 Hours or 24
Hours) using ARROW buttons.

* Wake Up Mode: Enter the
time for the receiver to
automatically power ON. And
you can choose one of Wake

Up Mode as ‘off” or ‘Once’ or
‘Daily’ or ‘Weekly’.

Wake Up Date: Select the date
when the STB is turn on.
Press the 0K button to display
calendar.

Wake Up Days: Select a day of
the week when the STB is
turn on.

Wake Up Time: Enter the wake
up time of the STB using the
NUMERIC buttons.

Wake Up Service: Select the
service when the STBis turn
on. Press the OK button to
display the service list.

Sleep Mode: Enter the time for

the receiver to automatically
switch OFF and go to

standby mode. And you can
choose one of the Wake Up
Mode as ‘off” or ‘Once’ or
‘Daily’ or ‘Weekly’.

Sleep Date: Select the date
when the STBis turn off. Press
the OK button to display the
calendar.

Sleep Days: Select a day of the
week when STB is turn off.

Sleep Time: Enter the turn-off
time of the STB using the
NUMERIC buttons.

2.5 Language Setting

4 Menu Language: Select the
desired menu language by
using the ARROW buttons.

NOTE: The menu and operation
languages can be changed
depending on the country sold.
Available languages are subject
to change without prior notice.

* Audio Language: Select the
default language for the
audio when changing
services. If no other language
is provided, then the default
language of current will be
automatically selected.

¢ Subtitle Language: Select the

default language for subtitle
when changing service.
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¢ Teletext Language: Select the
default language for Teletext.

# User Font file: Select a font you
want to use.

NOTE: To show and use the

User Font, please install a
desired font file(*.ttf) to the /
Var/Font directory(folder) in
your PCwhich is connected with
your receiver(STB) by network.
Then press LEFT/RIGHT button to

select a font and press OK button.

2.6 A/V Qutput Setting

* TV Type: Select the TV
types.(PAL/NTSC/Auto)
In Auto mode, the STB is
automatically selected to
NTSC or PAL accordingly to
the service played.

# TV Aspect Ratio: Select the
aspect ratio of TV which
is connected to the STB
(4:3/16:9). This menu must
be set prior to selecting the
Display Format function.

# Display Resolution: Select the
Display Resolution of the
screen by using ARROW or 0K
button. You can also change
the resolution with Resolution
button in the remote. Each

time you press the Resolution
button, the resolution
changes in the following
sequence: 576i > 576p >720p >
1080i > 1080p.

NOTE: Please note that your TV
may not show a picture depending
on the Display Resolution set by
your STB as well as if set to PAL
when NTSC is required or vice versa.
If you set the Display Resolution

as HD (more than 576p), your TV
cannot display anything when the
TV is connected to the Composite
Video output of the STB. In case of
HDMI, your TV can display a picture
for all of the resolution settings of
the STB. But it is also possible that
your TV may not display a picture
with 576i, because some HDTV's
does not support 576i.

« Display Format: In case of a 4:3
ratio TV set, you can select
Letter Box or Pan&Scan. In
case of a 16:9 ratio TV set, you
can select Pillar Box or Full
Screen.

- 16:9 Display format on 4:3 TV set
Letter Box: You can see the

full screen of 16:9, but top
and bottom edges of your
TV screen display black
horizontal Pillars.

- Pan&Scan: The picture is
displayed in full on your 4:3
TV screen, but left and right
sides of the original picture
cannot be displayed.

- 4:3 Display format on 16:9 TV set
Pillar Box: You can see the full
screen of 4:3, but left and
right sides of your TV screen
display black vertical Pillars.
4:3

- Full Screen: The picture is
displayed in full on your 16:9
TV screen, but left and right
sides of the original picture
is displayed with widening of
the screen from left and right.

Because of the artificial widening,

the TV picture will be distorted.

¢ Video Output Mode: According
to Display Resolution, you can
select the Video Output Mode.

- In case of More than 576p(HD): The
‘RGB’ output will be disabled
automatically.
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¢ HDMI Dolby Digital: Set the
Dolby Digital mode ‘On’
or ‘Off”in status of HDMI
output.

* Dolby Digital Default: Set the
Dolby Digital Default mode
‘On’ or ‘Off". If you set ‘On’,
Dolby Audio will play on the
service that support Dolby
Audio.

# Sound Mode: Set the audio
mode output among the RCA
jack, optical SPDIF and HDMI
(Stereo/Mono/Left/Right).

# Power Saving in Standby Mode:
You can select the Power
Saving in standby Mode.

* Audio Sync Delay: To adjust
Audio Sync. You can adjust
from Oms to 400ms.

3. Installation

3.1 Dish Setting

Select the satellite/antenna

and LNB settings for service

search. The values that are set
in this menu will be available
for selection in other service
searching menus.

* Satellite: Select the satellite
which you want to do a
search for.

- Press the LEFT/RIGHT ARROW
button to select the satellite.

- If you press the OK button,
the entire satellite list will be
displayed.

- Select the desired satellite
name to search.

- If the desired satellite name

is not listed then select User
Defined.

* Frequency: Select the satellite
frequency which you want to
use for checking the signal.

# LNB Power: Select the LNB
power on or off.

* LNB Type: Select the LNB type.

* LNB Frequency: Select the local
oscillator (L.O.). frequency
that is specified for the LNB
used.

- Use the LEFT/RIGHT ARROW
buttons to select the LNB
frequency.

- If the required LNB frequency
is not listed, then enter the
frequency manually using the
NUMERIC buttons.

- When you select Universal

LNB type, both 9750 and
10600 are supported at the
same time. And then the LNB
22KHz setting is disabled.

¢ LNB 22KHz: When you use a

separate coax 22 KHz tone
switch box, make the 22

KHz tone switch enabled or
disabled to select the input
you desire of the tone switch.

* DiSEqC Switch: If you use DiSEqC

1.0 or DiSEqC 1.1 switch, select
one of the DISEqC inputs.

# Service Search: Press the 0K

button to move to the Search
Menu.
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3.2 Positioner Setting

* Satellite: Select the satellite
which you want to search for
the Service.

- Press the LEFT/RIGHT ARROW
button to select the satellite.

- If you press the OK button, a
complete satellite list will be
displayed.

- Select the wanted satellite
name.

- If desired satellite name is not
listed then select User Defined.

* Frequency: Select the satellite
frequency you want to use to
check for a signal.

# Positioner: Select the
positioner.

- None: (No Positioner)

- Using DiSEqC1.2:

Move: To move the dish, press
LEFT/RIGHT button.

Fine Move: To move the dish in
smaller steps, press the LEFT/
RIGHT ARROW button.

Step: Set to positioner moving
stepsas 1,2, 3,4

Positioner Command: To use
various positioner commands,
press the OK button.

Then, available positioner
commands will appear.

Using USALS:

Dish Longitude: Enter the
longitude position of the
antenna using the NUMERIC
buttons.

Dish Latitude: Enter the latitude
using the NUMERIC buttons.

Go To: Press the OK button to
rotate the dish to the selected
antenna position.

Positioner Command: To use
various positioner commands,
press the 0K button.

Then, available positioner
commands will appear.

- Dish Setting: Press the OK

button to move to Dish Setting
menu directly.

- Service Search: Press the 0K

button to move to Service Search
menu directly.

3.3 Service Search

# Auto Search Mode:
- Satellite: Press the 0K button to

select the target satellite to be
searched.

Search Type: Select the search
type.

Network Search: You can select
Off or On. When you select
‘On, you can find more
transponders using the home
network. As it refers to NIT
during searching, if there is
the frequency information of
other transponder, it searches
the other transponder besides
the transponder that the user
inputs.
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- Time Calibration: You can select
‘Simple] ‘Full’and ‘Off’ to get
TDT (Time Data Table) from
each TP.

- Dish Setting: Press the 0K button
to move to Dish Setting menu
directly.

- Positioner Setting: Press the
0K button to move to the
Positioner Setting menu
directly.

- StartSearch: Press the 0K button
to start search.

< Manual Search Mode:

- Satellite: Press the OK button to
select the target satellite for
search.

- Frequency: Select the frequency
from the list to search.

Symbol rate: Enter the symbol
rate using the NUMERIC
buttons.

Polarity: Select the polarity.
(Vertical/Horizontal)

Search Type: Select the search
type.

Network Search: You can select
Off or On. When you select
‘On; you can find more
transponders using the home
network. As it refers to NIT
during searching, if there is
the frequency information of
other transponder, it searches
the other transponder besides
the transponder that the user
inputs.

Dish Setting: Press the OK button
to move to the Dish Setting
menu directly.

Transmission: You can select
‘DVB’and ‘DVB-S2’

Start Search: Press the 0K button
to start a search

Blind Search Mode:

Satellite: Press the 0K button to
select multiple satellites.
Frequency: Set Auto to search
whole frequency, Set Manual to
search only desired frequency.
Polarity: Select the polarity. (All
Polarity/Vertical/Horizontal)

Search Type: Select the search
type.

Dish Setting: Press the OK button
to move to the Dish Setting
menu directly.

- Start Search: Press the 0K button

to start a search.

¢ Fast Scan:
- Select operator: Press the 0K

button to select Operator.

- Select HD/SD Service: Press the

0K button to select HD/SD
Service.

- Start Search: Press the 0K button

to Start Search.

Advanced Search Mode:
- Satellite: Press the OK button to

select the target satellite for
search.

- Frequency: Select the frequency

from the list to search.
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Symbol rate: Enter the symbol
rate by using the NUMERIC
buttons.

Polarity: Select the polarity.
(Vertical/Horizontal)

Video PID: Enter the video PID
using the NUMERIC buttons.
Audio PID: Enter the audio PID
using the NUMERIC buttons.
PCR PID: Enter the PCR PID
using the NUMERIC buttons.
Transmission: You can select
‘DVB’and ‘DVB-S2’

Start Search: Press the 0K button
to start a search.

3.4 Network Setting

To use a Network connected to
the STB Ethernet port, you have
to prepare the STB Network
settings. When the STB and a

PC are connected via a network,
you can access the files of the
STB storage device such as USB
storage device.

NOTE: If you use DHCP function of
router, you can set easily network
configuration.

* DHCP: You can select On/Off
for the Dynamic Host Con-
figuration Protocol (DHCP) to
get the all configuration from
the router.

- Ifyouselect ‘On’: You will

obtain the configuration
from network and be set up
automatically. In this case, the
remaining item (IP Address,
Subnet Mask, Gateway,

First DNS, Second DNS) are
automatically set and you
don't have to configure them
manually.

Ifyou select “0ff: You have to
input the IP address manually
together with the following
data.

- IP Address, Subnet Mask, Gateway,

First DNS, Second DNS: You can
input the address with the 0K
button, NUMERIC buttons and
the LEFT/RIGHT buttons. You
can move to the next item of
Subnet Mast with the DOWN

button and you can configure
the following items in the
same way.

¢ Firmware Upgrade Server: To
upgrade the firmware by
downloading from a internet
server.

NOTE: Server installation and

settings must be controlled

by expert server manager. A storage

device must be connected with

your receiver (STB) when firmware

upgrade from server.

MAC Address: This will display

the MAC address of the STB

Ethernet interface and is a fixed

assignment unique to each STB.

# Control of the files via the network
and your PC:
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- Check the IP Address of STB
on the Network Setting menu.

- Press Enter button on your PC,
after writing IP Address on the
web browser address line. Ex.)

\\192.168.01.10\storage

- You can see the folder name
of USB in the Storage folder.

- USB: Rear USB Storage Device

- You may be able to load and
retrieve data between the PC
and the STB via the browser.

* Dynamic settings (RED key)

- You can make your DDNS
setting in this menu by
pressing the RED button.

- For more details about your

DDNS settings, please ask your
local DDNS service provider.

* Wireless LAN can be
supported by using the ‘USB
to Wi-Fi’ module connected
(*Option)

- By pressing the BLUE button,

you can automatically find
and do the settings for AP.

- For the details of Wireless Wi-
Fi settings, please refer to the
additional AP manual.

NOTE: The speed of Wireless LAN
is slower than the Wired LAN. So, it
could take much more time when
afile copy / move functions are
performed.

NOTE: Inevitably, only the limited
types of Wireless LAN modules are
supported. So, you MUST check for
the compatible / supported types
BEFORE you purchase.

Currently supported types are: RT73
series, RT3070 series, RT2870 series.

3.5 System Recovery

# System restore to factory default:
Restore the factory set
values in case the user has
encountered some problems
after changing any new
parameters of service data
and other parameters which
may be in error. Press the 0K
button to erase all services
and restore default setting.

# Reset Configuration data: Maintain
the service data and reset the
configuration data.

# Reset Service data: Maintain
configuration data and reset
the service data.

# System restore to stored
position: Restore the stored
values including service data
and system parameters. Press
0K button to restore all data.

# Store system data: If you want
to use system parameters
and service data in the future,
this menu allows you to store
current state. Press OK button
to store current state.

¢ Delete store position: Delete
stored system data.

3.6 System Information
This menu displays general
information about the
hardware and software
version of your receiver.
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4. Utility

4.1 Calculator

To use the calculator, highlight
the calculator and press the 0K
button.

4.2 (alendar
To display the calendar,

highlight the calendar and press

the OK button. Utilize the ARROW
buttons to choose the date. If
you press PAGE UP/DOWN button,
you can see the past/next
month of the calendar.

4.3 CAS (Conditional Access System)

< Smart Card Slot
- Conax smart card menu:
To watch scrambled services,

you need to have an
appropriate Conax smart card
from the service providers.
Insert a valid smart card into
smart card slot (only the
bottom slot of the two is
active). The message of ‘Smart
card Initializing..." will appear
on the screen. After message
disappears, you can watch the
service you want.

- Smart card information:

You can view the current sta-
tus of smart card. Select the
slot which you want to view
using the ARROW buttons. And
press the OK button.

¢ (AM Initializing

To watch scrambled services,
you need to have a Common

Interface Conditional Access
Module(CAM) and an
appropriate smart card from
the provider. Insert the CAM
together with a valid smart
card into Cl slot (two slots
available). The message of ‘CI
Initializing...’ will appear on
the screen. After the message
disappears, you can watch the
service you want.

CAM information

You can view the current
status of CAM. Select the slot
which you want to view using
the ARROW buttons, and press
the OK button. If the CAM

is available, you can view
information about each slot.

NOTE: The displayed
information of each CAMs
may be different depending
on the CAM used.

¢ (I message

- On:To display the Cl message
on live TV service.

- Off:To disable the Cl message
on live TV service.

4.4 Plugin

If you have the program file for
Plugin, you can download the
file(s) to Plugin then enjoy the
program.

* Download Plugin File

- Inthe USB storage, please
create a new folder name
‘plugin’ and in this ‘plugin’
folder, create a folder name
‘bin’. (plugin > bin)
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- GREEN button: To Start the
plugin. You will see ‘Started’

in State if the plugin is started. GO SIL
- BLUE button: Press BLUE button if
you want to delete the plugin Suton 0 o iy iy
file.
* We provide a special feature
called WebZeal which is e T —— i

for Web-Browsing. You can
simply enjoy the WebZeal

- Store (Copy) the plugin file in NOTE: Ifyou are using WebZeal 45 FreeTV+
the ‘bin’folder. when you want web surfing. by File Mount Drive, current USB © What iis Free TV+?

- Connect the USB storage to ¢ Executing WebZeal with storage device will not allow to use atis r.ee
the receiver. When Software USB Storage device PVR functions such as recording - Free TV+is a unique feature
Download menu is appeared, - Stored the WebZeal fileto the g1 time-shift. But it can be use that 'enables you to pla}/
then press LEFT/RIGHT ARROW USB storage device. e W el s e i ea & enjoy FREE web media

contents like Youtube and

WebZeal Option other free (but premium)
contents from various

buttons to move to User Data file name: ‘WebZeal-201xxxxx.mnt’.

Download mode. - Connect the USB storage

- Press RED button to start : : - RED button: P to set th
download the plugin file that device to your receiver then utton: Fress to set the internet websites such as
go to Menu > System Tools > current web page as home. d
you want. ocumentary and more.
Storage Manager. - GREENbutton: Presstoaddthe .
NOTE: You can also download Set the Current Device to File current web page to favorite. Y Joy watching
by Menu > System Tools > Data . and also downloading various
Y Mount Drive. - YELLOW/BLUE button: Press to i
Transfer > Data download from ) free web contents with our HD
il Set the Mount File Name to adjust the page ZoomInand  yaceijver.
storage. WebZeal-201xxxxx.mnt Zoom Out as you want. + Reauired setti
¢ Plugin Menu Press Connect then go to Menu - MENU button: Press MENU button eqmre settings
- RED button: To set the plu- > Utilities > Plugin 1o start the to show simple internet - Toenjoy your great Free TV+
gin Start Type. You can select  WebZeal. menu. feature, please make sure
Auto or Manual. to check for the following

conditions.
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- STB (Set-top-box) should be connected with Ethernet cable, with
proper network settings. (Please refer to the menu of “Network
setting”, and its operating instructions).

- USB or HDD storage requirement

Mode USB or HDD storage | Remark
connection

Playing Not Required For playing function, no additional
storage connection is required.
The internal Flash memory in the STB
will be used automatically for the
buffering of the contents being played.

Downloading | Required The available web contents can also

be downloaded to your USB or HDD
storage connected.

If more than one storage devices are
connected with the STB at the same
time, then the Downloaded files will be
saved at the faster and bigger storage
device automatically.

NOTE : a) Problems in network environment: Problems such as flickering
and freezing of the screen can occur while you are watching the YouTube
service. These kind of problems can often occur due to the lagging and
poor network status from your local internet service provider at home. This
may also cause the STB to be halted, then we kindly recommend you to
reboot your STB by resetting Power.

* Control part Play:

Select the media content you
wish to play, and press OK
button.

Settings (Red button):

You can set Picture quality, Unit

seek time and Parental lock

options.

- Country: You can change the
available contents area where
you would like to watch
(this option is only valid for
YouTube).

- Picture Quality:

High — Medium — Low

- Unit Seek Time: Set Forward

and Backward seeking time

interval for 10/20/30/ 60 sec.

- Parental Lock: You can lock
each contents and video
downloading function with
password.

Category (Yellow button):

Press this Yellow button to
view the list of categories,
then choose the one you
prefer to watch in the list of
contents.

Service (Green button):

You can select among various
free contents provided from
web-site.

- Note: Each web-site is
removable by pressing Green
key on the list.

Download (Recording button):
Web contents are available for
download into USB or HDD
storage.

NOTE: If more than one storage
devices are connected with the
STB at the same time, then the
Downloaded files will be saved
at the faster and bigger storage
device automatically.

Backward and Forward (Rewind and

Fast forward button) playing

- Note: Forward and Backward
seeking interval can be set for
10/20/30/60 sec at Settings
menu.

Full Screen: Press OK button to

view in full screen size.
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4.6 Internet TV+

* Whatis Internet TV+?
Internet TV+ feature enables
you to watch the‘Media
contents’ being served

from the Internet through a
specific URL. Itis just like a
web-browsing but watching
TV instead of web contents.
This feature is not only
supporting the streaming of
the live broadcast service,
but also supports FMS (Flash
Media Server) and Wowza
server (RTMP)

¢ Required settings

All users are required to do
the below settings before
you can enjoy the Internet
TV+ feature with your set-
top-box (STB).

STB should be connected
with Ethernet cable, with
proper network settings.
(Please refer to the menu

of “Network setting’, and its
operating instructions).

* Control part

Play: Select the service which
you wish to play, and press
OK button.

Add: User can add the URL
of the specific site which
they want to watch. And
they can add more sites
continuously.

Pa) Install Type: You
can define the type of URL.
(default: Input URL)

# Title: You can input
the name of the media
contents here.

s URL You can input
the URL address that you
would like to watch.

& Description: You
can define the description
of contents here.

“ Media Type: You
can choose the type of
Media service between the
“File” and “Live".

NOTE: Supported protocols are
RTMP, RTMPT, HTTP only.

The codec types supported in this
Internet TV+ feature are;

Video: MP1V, MP2V, MPEG4P2
(MP4), H.264, VC1

Audio: MP1A, MP2A, MP3A, AC3,
AAC, PCM

Edit : You can edit the existing
contents that you have.
Delete: You can delete
contents you have with this
function.

Full Screen: You can watch the
contents with full screen size
with this function.
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Problem Solution

Does not display any messageon ¢ Check the main power cable and check that it is plugged into a suitable power

the front panel. outlet.

Check the STB main power switch ‘ON’ at the rear of the STB.

No Picture

See ‘Does not display any message on the front panel’ above.

To match the STB system with your TV system (PAL/NTSC), press V.Format button until
a picture is displayed.

Check the video output port is firmly connected to the TV or VCR.

Check that you have selected the Video Input on your TV.

Press the STB button on the remote to assure you are controlling the STB and no
other device with the remote.

Check the brightness level of the TV.

Check the resolution that your TV supports, and set the proper resolution with the
remote Resolution button to obtain a picture.

Poor picture quality

+ See ‘No Picture’ above.
¢ Check the signal level, if this is low then tries adjusting the alignment of your dish.

No Sound

See ‘No Picture’ above.
Check the volume level of the TV and STB.
Check the Mute status of the TV and STB.

Remote Control does not operate

*

* o

Point remote control directly towards the STB.
Check that the STB button lights up when you press any button
Check and replace batteries.

No or Bad Signal

Troubleshooting

* & o o

Check the LNB; Replace the LNB if necessary.

Check the cable from the LNB.

Check the position of the dish; realign dish if necessary.

If you are using a DiSEqC 1.0 switch, check that you have connected and
programmed the LNBs to the correct connections on the switch.

Check the ‘Signal Level’ and the ‘Signal Quality’.
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Tuner & Channel Decoder

Input Connector
Loop through out
Frequency Range
Input Impedance

Signal Level

LNB Power

22KHz Tone
DISEqC Control
Demodulation
Input Symbol Rate

FEC Decoder

F-type, IEC 169-24, Female

F-type, IEC 169-24, Female

950MHz ~ 2150MHz

75Q), unbalanced

-65 to -25dBm

13/18VDC, max.400mA

(22+2)KHz, (0.6+0.2)V

V1.0/1.2/USALS Compatible

QPSK/ 8PSK

2 ~67.5 Ms/s(QPSK of DVB-S), 2 ~ 52.5 Ms/s(8PSK of DVB-S2)
1/2,2/3,3/4,5/6 and 7/8 with Constraint Length K=7(DVB-S)
3/5,2/3,3/4,4/5,5/6,8/9 and 9/10 (DVB-S2)

MPEG Transport Stream A/V Decoding

Transport Stream

Profile Level
Input Rate

Video Formats
Video Resolution

Specifications

Audio Decoding
Audio Mode
Sampling Rate

H.264(MPEG-4 part 10, MPEG-4/AVC and H26L)

MPEG-II ISO/IEC 13818-2/11172-2

MPEG-4/AVC MP@L4, MPEG-Il MP@HL

Max. 80Mbit/s

4:3 Letter Box, 4:3 PanScan, 16: 9

720 x 576i, 720 x 576p, 720 x 480i, 720 x 480p,

1280 x 720p, 1920 x 1080i, 1920 x 1080p(supports only HDMI)
Dolby Digital, MPEG-1 Layer 1,2 and 3

Stereo/Joint stereo/Mono, Dolby AC-3

32KHz, 44.1KHz and 48KHz (According to input)

Main System

Main Processor
Memory

STi chipset
Flash-ROM: 32 Mbyte, SDRAM: 256 Mbytes , EEPROM: 256 bytes
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Audio / Video & Data IN/OUT

RCA

HDMI
OPTIC
RS-232C
UsB
Ethernet

IR extension

CVBS Video Output, Audio L, R Output

Video & Audio Output

AC-3 Dolby Digital (SPDIF)

9 pin D-SUB (Male) type, Transfer rate 115Kbps
USB 2.0 Host Support

TX 10/100M Base

Removable IR extension

Front/ Rear Panel

Slot
Buttons
Indicators

Common interface & 1 Smart Card Slot (Rear)
3 Buttons(Standby, CH UP/DOWN)
1 LEDs (Standby, Power and Remote: DUAL TYPE)

Power Supply

Input Voltage

Type

Power Consumption
Protection

AC 100 ~ 240V, 50/60Hz

ADAPTOR (12V,2A)

Max.24W

Separate Internal Fuse & Lighting protection

Physical Specification

Size (W xHx D)
Weight (Net)
Operating Temp.
Storage Temp.

220mm X 35mm X 145mm
0.6 Kg

0°C ~ +45°C

-10°C ~ +70°C

Specifications and features are subject to change without prior notice.





